
Для описания инструментов раз�

мещения компонентов и трассиров�

ки проводников, а также приёмов

одновременной работы со схемой

и платой воспользуемся проектом

Example_Rule, который можно най�

ти в дополнительных материалах на

интернет�странице журнала (www.so�

el.ru). Описанный проект содержит

несколько документов схем и один

файл платы, в котором имеются за�

груженные компоненты и установле�

ны простейшие правила проектиро�

вания, создание которых было опи�

сано в предыдущей статье (СЭ № 9,

2008). Несмотря на то что програм�

ма Altium Designer оснащена автома�

тическими и полуавтоматическими

инструментами размещения компо�

нентов на плате, любой опытный

конструктор знает, что ни одна

программа не способна разместить

компоненты на плате лучше челове�

ка. Учитывая низкую эффектив�

ность автоматического размещения,

в статье будут рассмотрены только

ручные и полуавтоматические сред�

ства размещения, к которым отно�

сят инструменты группы Tools >

Component Placement. Большую роль

здесь играют т.н. «комнаты» (Rooms) –

области платы, за которыми за�

креплены некоторые группы ком�

понентов. Прежде чем приступить

к описанию инструментов полуав�

томатического размещения, рас�

смотрим, как сформировать комна�

ты на плате.

СВЯЗАННОСТЬ МЕЖДУ СХЕМОЙ
И ПЛАТОЙ

При передаче информации из схе�

мы в плату программа Altium Designer
автоматически формирует комнаты

на плате, если это не отключено в наст�

ройках. Комнаты формируются со�

гласно листам схемы, и наиболее целе�

сообразно применять комнаты в тех

случаях, когда имеются повторяющие�

ся фрагменты схемы. В нашем случае

проект содержит несколько блоков

PortIO с индексами A, B, C и D в правой

части главной схемы (см. рис. 1). В

цикле публикаций пока не обсужда�

лись иерархические проекты, как в

рассматриваемом примере, – им бу�

дет посвящена одна из последующих

статей. Сейчас можно выполнить

синхронизацию схемы с платой, и

информация о комнатах будет пере�

дана на плату. Мы выполним эту про�

цедуру позднее, т.к., во�первых, имеет

смысл проверить настройки синхро�

низации и, во�вторых, возможность

установки классов цепей и правил

проектирования на схеме и их пере�

дачу в плату. Настройки синхрониза�

ции задаются в окне Project > Project
Options на вкладке Comparator (см.

рис. 2).

Для чего это необходимо? Напри�

мер, после создания схемы информа�

ция была передана в плату, и на плате

были созданы классы цепей. При об�

новлении схемы и попытке передать

информацию на плату программа об�

наружит классы цепей, которые не
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Основным этапом разработки платы является процедура
расположения компонентов с учётом технического задания
и формирование топологии печатных проводников. В данной статье
будут рассмотрены ручные и автоматические средства размещения
компонентов и трассировки. Указанная работа должна проводиться
с учётом схемотехнических особенностей разработки, поэтому
будут рассмотрены и вопросы, касающиеся параллельной работы
схема – плата.

Altium Designer Winter 09 –
Размещение компонентов на плате
и трассировка печатных проводников

Алексей Сабунин (Москва)
совпадают на схеме и плате, и пред�

ложит либо удалить их, либо объеди�

нить с существующими и т.д. Также

по умолчанию программа не перено�

сит дифференциальные пары со схе�

мы на плату! Чтобы исправить ука�

занные элементы, необходимо ука�

зать параметры синхронизации, как

показано на рисунке 2.

Теперь посмотрим, как на схеме

создать класс цепей, правило проек�

тирования или описать дифферен�

циальную пару. Для всех этих элемен�

тов используется одна метка (Para�
meter Set), которую можно установить

с помощью команд Place > Directives.

Так, метки PCB Layout, Net Class и

Differential Pair используются для соз�

дания правила, класса цепей и диф�

ференциальной пары соответствен�

но. Рассмотрим описанные возмож�

ности на примере формирования

правила проектирования; другие

применения метки Parameter Set мож�

но посмотреть в документе TR0111

Schematic Editor and Object Refere�

nce.pdf фирменной документации

Altium.

В качестве примера зададим прави�

ло, которое будет ограничивать тол�

щину всех цепей шины OUT значени�

ем 0,15 мм. Для этого откроем схему

PCB_PortIO1D.SchDoc из проекта exam�
ple_rules.PrjPcb и командой Place >

Directives > PCB_Layout установим

метку на шину OUT[16..0], как показа�

но на рисунке 3. Установленная метка

пока не несёт никакой информации,

поэтому следует описать её свойства,

для чего выполняем на ней двойной

щелчок мыши. В свойствах нажима�

ем кнопку Edit и далее в появившемся

окне – кнопку Edit Rule Value. На экра�

не появится список всех правил про�

ектирования, из которого следует

выбрать правило толщины провод�

ников (Width Constrain). Теперь на эк�

ране показано окно, знакомое по

статье в СЭ № 9, 2008 (см. рис. 4).
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Здесь необходимо указать минималь�

ную, рекомендуемую и максималь�

ную толщину проводника, после чего

следует закрыть все окна нажатием

кнопки ОК.

Итак, теперь мы имеем на схеме

правила, которые необходимо пере�

дать в плату, т.е., другими словами,

необходимо синхронизировать схе�

му с платой. В программе P�CAD для

этого существовали две различные

процедуры: во�первых, загрузка

списка соединений (NetList), во�вто�

рых, загрузка списка изменений

(ECO). В программе Altium Designer
они заменены одной процедурой,

которая может выполняться в любой

момент работы с проектом. Причём

можно синхронизировать не только

схему с платой, но и плату с ПЛИС,

ПЛИС со схемой и т.д. Для синхрони�

зации схемы с платой (или для пер�

вичной загрузки элементов схемы

на плату) необходимо, находясь в

редакторе схем, выполнить команду

Design > Update PCB Document
Example_rules.PcbDoc, после чего по�

явится окно с надписью Engineering
Change Order, знакомой всем разра�

ботчикам P�CAD по аббревиатуре

ECO (см. рис. 5). Здесь перечислены

все отличия между двумя документа�

ми, и предлагается выбрать пункты

для импорта изменений. В конце

этого списка находятся две группы

(Add Room и Add Rules), которые до�

бавят созданные нами правило и

комнаты на плату. Для внесения из�

менений в плату необходимо после�

довательно нажать кнопку Validate
Changes, которая проверит возмож�

ность внесения указанных измене�

ний, и затем Execute Changes и Close.

В результате проделанных дейст�

вий на плате появятся комнаты, кото�

рые автоматически располагаются в

начале координат. Эти комнаты сле�

дует аккуратно расположить на плате

с учётом конфигурации групп компо�

нентов, которые привязаны к облас�

тям. Помните, что при перемещении

комнаты перемещаются и компонен�

ты, закреплённые за ней. Поэтому для

позиционирования комнаты необхо�

димо её выделить, а затем изменять

форму и положение, перетаскивая

метки, расположенные в вершинах

комнаты. Для данного проекта следу�

ет расположить комнаты так, как по�

казано на рисунке 6.

39СОВРЕМЕННАЯ ЭЛЕКТРОНИКА ◆ № 2 2009 WWW.SOEL.RU

ПРОЕКТИРОВАНИЕ И МОДЕЛИРОВАНИЕ

© СТА�ПРЕСС

Рис. 1. Структура проекта

Рис. 2. Настройки синхронизации проекта



РАЗМЕЩЕНИЕ ЭЛЕМЕНТОВ
Теперь можно приступить к разме�

щению компонентов. Сначала раз�

местим компоненты, относящиеся к

комнате PortO1. Первым действием

переместим соответствующие ком�

поненты в комнату, затем подправим

размещение компонентов внутри

участка. Выполним команду Tools >

Component Pacement > Arrange Within
Room, которая перемещает компо�

ненты, принадлежащие указанной

комнате, и выберем на плате комнату

PortO1. Выполненная команда не

учитывает правила проектирования,

а просто перемещает элементы в ука�

занную комнату. Теперь скорректиру�

ем положение элементов вручную

(см. рис. 7). В процессе размещения

можно пользоваться интуитивной

подсказкой в виде линии связи, цвет

которой меняется от красного к зелё�

ному. Зелёный цвет говорит об

уменьшении суммарной длины це�

пей, отходящих от выбранного ком�

понента.

После ручного размещения компо�

нентов, принадлежащих комнате

PortO1, можно автоматически раз�

местить три комнаты с аналогичным

составом. Для этого выполним ко�

манду Design > Rooms > Copy Room

Format, которая позволяет копиро�

вать параметры комнат. При этом

курсор приобретает вид крестика,

после чего следует последовательно

задать комнату – образец и конечную

комнату. В нашем случае сначала вы�

бираем комнату PortO1, затем PortO4;

в появившемся окне предлагается

скопировать следующие параметры

(см рис. 8):

● размещение компонентов в комнате;

● положение и форматирование по�

зиционного обозначения;

● топологию внутри комнаты;

● форму и размеры комнаты;

● применить вышеперечисленные

команды не ко всем объектам ком�

наты, а только к выбранным.

Выбираем параметры, отмечен�

ные на рисунке 8, и кнопкой ОК за�

вершаем размещение компонентов

второй комнаты. В результате наших

действий комната, оформленная по

образцу, встаёт вертикально, и про�

грамма не выходит из инструмента

копирования формата комнаты, по�

этому выполняем ту же самую коман�

ду для остальных типовых комнат, и

правой кнопкой выходим из этого

инструмента. После этого можно пе�

ремещать комнаты с расположенны�

ми в них объектами. Поэтому пози�

ционируем четыре комнаты, с кото�

рыми велась работа, так, как они

были размещены на предыдущем эта�

пе (согласно рисунку 6).

Описанная ситуация, когда на пла�

те имеются несколько одинаковых

каналов, встречается не часто, но раз�

личные элементы описанной после�

довательности можно использовать и

в других случаях. Рассмотрим теперь

более востребованный инструмент,

который позволяет размещать ком�

поненты на плате кластерами, по�

штучно. Выглядит это следующим

образом: на схеме выделяются ком�

поненты, которые по схемотехничес�

ким соображениям должны быть раз�

мещены определённым образом и

заранее известным способом (наибо�

лее часто это относится к микросхе�

мам с элементами их «обвязки»), за�

тем специальный инструмент будет

предлагать размещать эти компонен�

ты поштучно в едином цикле. По�

смотрим, как это делается на конк�

ретном примере. Прежде чем присту�

пить к решению описанной задачи,

убедимся, что на схеме и плате вклю�

чена настройка Tools > Cross Select
Mode, которая обеспечивает одновре�

менное выделение объектов в обоих

редакторах. Теперь на схеме FPGA
Sheet1.SchDoc выделим компонент

U1A, затем переключимся на схему

FPGA Symbol1.SchDoc и рамкой выде�

лим все конденсаторы в правой ниж�

ней части схемы.

После открытия файла платы мож�

но заметить, что компоненты, ука�

занные ранее на схеме, выделены на

плате. Далее выполняем команду

Tools > Component Placement > Re�
position Selected Components, в резуль�

тате программа будет поштучно

предлагать устанавливать выбран�

ные компоненты, начиная с микро�

схемы, которая на схеме была выде�

лена первой. Разместим последова�

тельно микросхему и относящиеся к

ней конденсаторы, как показано на

рисунке 9. Как правило, не у каждого

разработчика получится быстро уста�

новить конденсаторы ровными ли�

нейками. Поэтому после размеще�

ния элементов их можно выровнять

в указанном порядке или с заданным

интервалом, для чего используется

группа команд Align. В нашем случае

выделим рамкой группу конденсато�

ров слева от микросхемы и выпол�

ним команду Align > Align Right (вы�

ровнять по правому краю). В резуль�

тате будет получено более удачное

размещение выделенного фрагмента

(см. рис. 10). Большинство команд

группы Align, вызываемых ПКМ, ин�

туитивно понятны разработчикам.

Размещение остальных компонен�
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Рис. 4. Создание правила проектирования на схеме

Рис. 3. Метка правила



тов приведено в файле example_ru�
les_Full.PcbDoc.

ТРАССИРОВКА ПРОВОДНИКОВ
В редакторе P�CAD данная задача

могла решаться с помощью команд

Manual Route, Advanced Route или с

помощью одного из двух автотрасси�

ровщиков (Specctra или Situs для P�

CAD 2006). В описываемой програм�

ме имеется схожий инструментарий,

который, в отличие от P�CAD, облада�

ет большей гибкостью в настройках.

Начнём с интерактивной трасси�

ровки, которая в Altium Designer окон�

чательно вытеснила ручной режим.

Прежде чем приступить к трассиров�

ке, следует ознакомиться с некоторы�

ми настройками, которые будут по�

лезны в режиме прокладки проводни�

ков. Сначала обратимся к настройке

DXP > Preferences > PCB Editor >

General. Здесь большинству пользова�

телей, имеющих опыт работы с P�

CAD, будет неудобна опция автомати�

ческого панорамирования (Autopan

Options), поэтому рекомендуется её

отключить (Disable). На этой же

вкладке стоит обратить внимание на

число команд, которые можно отме�

нить (Undo/Redo). При длинной исто�

рии команд отмены и недостаточном

объёме оперативной памяти компью�

тера программа будет завершать ра�

боту всякий раз при нехватке памяти

с сообщением «Access violation at

address ХХХХХХХХ in module

'ADVPCB.DLL'. Read of address

ХХХХХХХХ at ХХХХХХХХ».
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Рис. 5. Внесение изменений из схемы в плату (Синхронизация проекта)

Рис. 6. Размещение компонентов с помощью комнат (Rooms)



Следующей страницей настроек,

важной с точки зрения трассировки,

является DXP > Preferences > PCB
Editor > Interactive Routing. Здесь в

группе Routing Conflict Resolution пе�

речислены режимы трассировки, ко�

торые определяют действие, приме�

няемое к прокладываемой трассе и

близлежащей топологии, при воз�

никновении конфликтной ситуации.

Во время трассировки эти режимы

переключаются комбинацией кла�

виш Shift+R, и мы рассмотрим их ни�

же на конкретном примере.

В группе Interactive Routing Connec�
tions перечислены дополнительные

параметры трассировки, из которых

можно отметить Automatically Remove
Loops – удалять старую дорожку при

прокладке новой (в отличии от P�

CAD, эта команда удаляет не только

сегменты трассы в одном слое, но и

повторяющиеся петли с переходны�

ми отверстиями), Auto Complete – ав�

томатически завершать прокладку

трассы при доведении дорожки до

центра. Группа Interactive Routing
Width/Via Sources задаёт значение

толщины дорожки и переходного от�

верстия, которое будет использовать�

ся по умолчанию, – здесь рекоменду�

ется выбрать настройку Rule Preferred
(предпочтительное по правилам). В

этой же группе кнопки Favorite зада�

ют типоразмер толщины дорожек и

параметров контактных площадок,

которые могут быть использованы

при трассировке. Следует отметить,

что возможность создавать перечень

стандартизованных переходных от�

верстий с указанием толщины пло�

щадки по слоям появилась только в

версии программы Altium Designer
Winter 09 (см. рис. 11). Толщина во

время трассировки изменяется ком�

бинацией клавиш Shift+W, переход�

ное отверстие – Shift+V. Если устанав�

ливаемое значение выходит за рамки,

оно автоматически ограничивается

верхним или нижним значением.

Режим размещения проводника на

плате включается командой меню

Place > Interactive Routing или соответ�

ствующей пиктограммой из инстру�

ментов меню . Рассмотрим режи�

мы интерактивной трассировки, для

чего после выбора инструмента Place >

Interactive Routing выберем началь�

ную контактную площадку и нажима�

ем клавиши Shift+R до появления ре�

жима Ignore. Название режима отоб�

ражается в строке состояния под

вкладками слоёв или во всплываю�

щей информации в левом верхнем

углу рабочей области; в данном слу�

чае должна быть видна надпись

Track45:Ignore Obstacle. Теперь по по�

рядку:

● Ignore Obstacle – игнорирование

препятствий. Практически ручной

режим, в котором не соблюдаются

ранее созданные правила проекти�

рования;

● Walkaround Obstacle – огибание

препятствий. Программа огибает

конфликтный объект с учётом ми�

нимальных зазоров и по оптималь�

ной траектории;

● Push Obstacle – «расталкивание»

препятствий; приоритет отдаётся

прокладываемой дорожке, и все

встречающиеся элементы тополо�

гии (трассы, переходные отверстия)

расталкиваются с учётом правил;

● Hug and Puhsh Obstacle – огибание и

расталкивание препятствий. В от�
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Рис. 7. Работа с комнатами



личие от режима Walkaround, про�

грамма огибает препятствия только

в заданном направлении, а не пред�

лагает оптимальный вариант. При�

чём в узких участках, при невоз�

можности обогнуть конфликтный

объект, дорожка отталкивает его в

сторону. Например, имея два про�

ложенных параллельно идущих

проводника, мы начинаем прокла�

дывать третью дорожку (см. рис. 12а).

Обратите внимание, что новая

трасса идёт сверху от имеющейся

топологии, а курсор расположен

снизу, – этим обеспечивается соз�

дание параллельной топологии.

Около конденсатора С204 для но�

вой трассы не хватает места, но

после проведения курсора левее и

ниже имеющихся проводников но�

вая дорожка «отталкивает» сущест�

вующие дорожки вниз.

Во время интерактивной трасси�

ровки используются горячие клави�

ши, показанные в таблице.

Интерактивная трассировка также

может быть выполнена для несколь�

ких параллельно идущих проводни�

ков (трассировка шин). Для этого

используется специальная команда

Place > Interactive Multi�Routing, кото�

рую можно запустить, используя пик�

тограмму . Прежде чем использо�

вать команду трассировки шин, сле�

дует выбрать контактные площадки,

от которых отходят параллельные

связи, а затем выполнить команду

Interactive Multi�Routing.

Выбрать несколько контактных

площадок можно рамкой выделения,

а также одиночным выделением с на�

жатой клавишей Shift. После того как

указаны площадки, запускается ко�

манда Interactive Multi�Routing, и затем

необходимо указать любую из вы�

бранных площадок. Во время трасси�

ровки шины действуют те же горячие

клавиши, что и в обычной трассиров�

ке (см. таблицу), например, режим

огибания препятствий (см. рис. 13а).
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Рис. 8. Копирование параметров комнаты

Рис. 9. Последовательное размещение выбранных объектов



Кроме того, можно изменять зазор

между проводниками шины, исполь�

зуя клавиши «.» (точка увеличивает

зазор между проводниками) и «,» (за�

пятая уменьшает зазор). К интерак�

тивной трассировке также относится

ещё один инструмент – трассировка

дифференциальной пары, который

по выполнению не отличается от

трассировки шин.

АВТОМАТИЧЕСКАЯ
ТРАССИРОВКА (SITUS)

Инструментарий автоматической

трассировки расположен в меню Auto
Route, в котором имеются следующие

инструменты:

● All – трассировать все проводники;

● Net – трассировать одну цепь;

● Net Class – трассировать класс цепей;

● Connection – трассировать все цепи,

подсоединённые к данному выводу;

● Area – трассировать все проводни�

ки, соединяющие выводы в выде�

ленной области;

● Room – трассировать все проводни�

ки между компонентами в выбран�

ной области размещения (комнате);

● Component – трассировать все про�

водники, подходящие к выбранно�

му компоненту;

● Component Class – трассировать все

проводники, подходящие к вы�

бранному классу цепей;

● Connections on selected components –

трассировать все проводники внут�

ри выбранных компонентов;

● Connections between selected compo�
nents – трассировать все проводни�

ки между выбранными компонен�

тами;

● Fanout – трассировать Fanout для

выбранного элемента (цепь, КП,

компонент и т.д.).

● Автоматическая трассировка от�

дельных элементов даёт неудовлет�

ворительный результат, т.к. отсут�

ствует возможность настройки её

алгоритма, который может быть

указан только для трассировки

всей платы. Соответственно, чтобы

удалить один или несколько разве�

дённых проводников, следует вы�

полнить Tools > Un�Route > All (Net,
Connection, Component, Room).

Предположим, что у нас имеется

«расстановленная» и частично разве�

дённая плата и необходимо выпол�

нить оставшуюся трассировку авто�

матически. Для этого выполним Auto
Route > All, после чего появится окно

Situs Routing Strategies (это же окно по�

является при выполнении Auto Route >

Setup, см. рис. 14). Данное окно служит

для настройки стратегии трассиров�

щика Situs. В верхней части окна пере�

числены все правила проектирования,

заданные для данного проекта; здесь

они доступны для редактирования.

Ниже, на вкладке Routing Strategy,

присутствуют шесть заранее заданных

эталонных стратегий трассировки:

● Cleanup – «чистка» топологии;
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Рис. 11. Создание списка используемых переходных отверстий

Рис. 12. Режим Hug and Puhsh Obstacle

а) б)

Рис. 10. Выравнивание компонентов (Edit > Align)



● Default 2 Layer Board – простая

двухслойная плата;

● Default 2 Layer With Edge Connectors –

двухслойная плата с торцевым

разъёмом;

● Default Multilayer Board – много�

слойная плата;

● General Orthogodnal – преимуще�

ственно ортогональная трасси�

ровка;

● Via Miser – трассировка с минимиза�

цией числа переходных отверстий.

Включение параметров:

● Lock All Pre�Routing – позволяет за�

фиксировать все ранее разведён�

ные цепи;

● Rip�Up Violations After Routing – уда�

ляет конфликтующие участки то�

пологии после трассировки.

При необходимости пользователь

может задавать свои стратегии трас�

сировки, для чего следует нажать

кнопку Add в окне Situs Routing
Strategies, после чего появится окно

Situs Strategy Editor (см. рис. 15).

В стратегию можно добавить следу�

ющие важные процедуры:

● Adjacent Memory – соединяет выво�

ды U�образными проводниками;

● Clean Pad Entries – «чистит» подхо�

ды к контактным площадкам;

● Completion – добивается завершён�

ности трассировки, для чего ис�

пользует методы разрыва и растал�

кивания препятствий;

● Memory (память) – находит все це�

пи, связанные с устройствами па�

мяти или похожие на таковые и ис�

пользует эвристический алгоритм.

Рекомендуется включать эту про�

цедуру всегда, даже в тех случаях,

когда на плате нет запоминающих

устройств. Если на разрабатывае�

мой вами плате присутствует на�

стоящий банк памяти и его место�

положение, ориентация и привязка

строго оговорены, для оценки его

разводки рекомендуется включить

только эту процедуру, а все осталь�

ные выключить;

● Fan Out Signal – прорисовывает

стрингеры у КП поверхностного

монтажа на сигнальных слоях;

● Fan Out to Plane – прорисовывает

стрингеры у КП поверхностного

монтажа с переходами на внутрен�

ние слои питания и заземления;

● Hug – уплотняет проложенные до�

рожки;

● Layer Pattern (шаблон для слоя) –

использует шаблоны трассировки с

учётом преобладающего направле�

ния на слое;

● Main – главная процедура тополо�

гической трассировки с использо�

ванием методов разрыва и растал�

кивания препятствий;

● Recorner – добавляет сглаживание

прямых углов;

● Spread – равномерно использует

доступное для прокладки место;

● Straighten – выполняет общую чист�

ку топологии.

После выбора стратегии трасси�

ровки запускаем программу Situs на�

жатием кнопки Route All в окне Situs
Routing Strategies.

В программе Altium Designer имеется

интерфейс обмена данными с про�

граммой Specctra. Для импорта в про�

грамму Specctra плата сохраняется с
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Функции горячих клавиш

Рис. 13. Трассировка шин

а) б)

Клавиша Описание выполняемого действия

Tab Отображает окно свойств текущего проводника

Enter Завершает трассировку прокладываемой дорожки

Backspace Удаляет последний излом проводника

Esc Отменяет текущую трассировку

Правая кнопка мыши Приостанавливает трассировку

Spacebar Переключает режим размещения трассы Start или End

Shift+пробел Изменяет режим размещения проводников

Shift+R Изменяет режим преодоления препятствий

Shift+W(V) Изменяет толщину проводника (размер переходного отверстия)

* Переключает слои трассировки в процессе размещения проводников

/ Устанавливает переходное отверстие и завершает прокладку трассы

~ Показывает все доступные в данный момент комбинации горячих клавиш



расширением *.dsn, для этого выпол�

ним команду меню File > Save As. На эк�

ране появится диалоговое окно, пред�

лагающее сохранить файл в одном из

поддерживаемых форматов экспорта.

В выпадающем списке в нижней части

окна выберем тип файла Export
Specctra Design File (*.dsn). Предлагае�

мое по умолчанию название файла ав�

томатически получит расширение

*.dsn. Далее следует указать папку, в ко�

торую будет сохранён наш проект.

Помните, что программа Specctra не

поддерживает имена папок с пробела�

ми, поэтому во избежание затрудне�

ний с последующей обработкой фай�

ла создадим в корневой директории

одного из дисков новую папку с назва�

нием Specctra. Оставим название про�

екта без изменений и закроем окно

нажатием кнопки «Сохранить». На эк�

ране появится диалоговое окно Setup
Specctra Router, которое содержит

настройки, управляющие передачей

данных о правилах проектирования и

стратегии в программу Specctra. На са�

мом деле это окно никак не влияет на

содержимое экспортируемого файла

и все эти настройки можно выставить

в самой программе Specctra, поэтому

просто закроем окно.

После трассировки платы в про�

грамме Specctra в созданной папке бу�

дут созданы файлы отчёта, главным

из которых является файл *.rte, содер�

жащий описание проложенных про�

водников. Именно его мы и будем им�

портировать в программу Altium
Designer. Выполним команду File >

Import и в появившемся окне выбе�

рем файл *.rte. Нажмём кнопку «От�

крыть». Программа загрузит нужный

файл и одновременно автоматически

откроет файл *.sts, содержащий отчёт

о выполненной трассировке. Щелч�

ком на вкладке с именем файла

*.PcbDoc вернёмся в редактор печат�

ных плат.

ПРОВЕРКА ПРАВИЛ
ПРОЕКТИРОВАНИЯ (DRC)

Программа Design Rule Checker
(DRC) представляет собой высоко�

производительный автоматизиро�

ванный программный модуль, про�

веряющий как логическую, так и

физическую целостность проекта

печатной платы. Использование

этого модуля при трассировке обя�

зательно для контроля соблюдения

минимальных зазоров и отсутствия

других нарушений. Так как редактор
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Рис. 15. Описание стратегии трассировки

Рис. 14. Настройки автоматического трассировщика Situs



печатных плат позволяет в любое

время вносить изменения в проект,

рекомендуется всегда выполнять

проверку правил проектирования

перед окончательным выводом чер�

тежей.

Функция проверки правил проек�

тирования в режиме реального вре�

мени активизируется на вкладке

PCB > General диалогового окна

Preferences. Включение этой функции

в режиме ручной трассировки позво�

ляет незамедлительно обнаружить и

выделить ошибки. Правила, проверка

которых будет производиться в ре�

жиме реального времени, настраива�

ются на вкладке Rule To Check диало�

гового окна Design Rule Checker (см.

рис. 16), вызываемого командой ме�

ню Tools > Design Rule Check. Для вклю�

чения правила в постоянную (online)

или ручную (batch) проверку следует

установить флаг в соответствующем

столбце напротив данного правила

(см. рис. 16).

Чтобы включить/выключить все

правила, следует нажать ПКМ на на�

звании любого правила и в выпадаю�

щем списке выбрать соответствую�

щее значение. Рекомендуется для

постоянной проверки выключить все

правила (Online DRC�All Off) и вклю�

чить только проверку зазоров по ме�

таллизации и между компонентами

(Clearance и Component Clearance). В

ручную проверку желательно вклю�

чить все правила, которые были соз�

даны для данного проекта (Batch
DRC�Used On).

Перед запуском ручной проверки

можно указать дополнительные па�

раметры на вкладке Report Options,

которые позволяют:

● Create Report File – автоматически

создавать файл отчёта программы

проверки правил проектирования

с расширением .DRC, который за�

тем открывается текстовым редак�

тором;

● Create Violations – подсвечивать на�

рушения; при включении этой

настройки места нарушения пра�

вил (примитивы) будут выделяться

заданным цветом;

● Sub�Net Details – работать совмест�

но с правилом проектирования

Unrouted Net Rule. Включается в слу�

чаях, когда требуется просмотреть

все детали неразведённых цепей.

Правило проектирования Unrouted
Net Rule должно включаться только

после трассировки всех соедине�

ний, т.к. виртуальная линия связи

соединений воспринимается про�

граммой проверки как разомкну�

тая цепь;

● Stop When XX Violations – автомати�

чески остановить процесс провер�

ки правил проектирования при на�

хождении заданного числа нару�

шений.

После трассировки проводников

выполните команду меню Tools > De�
sign Rule Check, после чего появится ди�

алоговое окно Design Rule Check. О ве�

рификации проекта будет рассказано

в одной из последующих статей. Более

подробно ознакомиться с вопросами,

описанными в данной статье, можно в

следующих файлах оригинальной до�

кументации Altium: AP0135 Interactive

and Differential Pair Routing.pdf, AR0128

Situs Autorouting Essentials.pdf, TR0112

PCB Editor and Object Reference.pdf.

На момент написания данной

статьи фирма Altium объявила о вы�

пуске новой версии программы –

Altium Designer Winter 09. Некото�

рые инструменты, описанные в

данной статье, работают только в

новой версии, но концептуальные

этапы работы одинаковы для всех

версий.

ПРОЕКТИРОВАНИЕ И МОДЕЛИРОВАНИЕ

Рис. 16. Список правил постоянной и ручной проверки




